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Documentation Updates
The title page of this document contains the following identifying information:
l
Software Version number, which indicates the software version.
l
Document Release Date, which changes each time the document is updated.
l
Software Release Date, which indicates the release date of this version of the software.
To check for recent updates or to verify that you are using the most recent edition of a document, go to:
https://softwaresupport.hpe.com/group/softwaresupport/search-result?keyword=.
This site requires an HPE Passport account. If you do not have one, click the Create an account button on the HPE
Passport Sign in page.
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Support
Visit the HPE Software Support website at: https://softwaresupport.hpe.com
This website provides contact information and details about the products, services, and support that HPE Software
offers.
HPE Software Support provides customer self-solve capabilities. It provides a fast and efficient way to access
interactive technical support tools needed to manage your business. As a valued support customer, you can benefit
by using the support website to:
l
Search for knowledge documents of interest
l
Submit and track support cases and enhancement requests
l
Download software patches
l
Manage support contracts
l
Look up HPE support contacts
l
Review information about available services
l
Enter into discussions with other software customers
l
Research and register for software training
Most of the support areas require that you register as an HPE Passport user and sign in. Many also require a
support contract. To register for an HPE Passport ID, go to https://softwaresupport.hpe.com and click Register.
To find more information about access levels, go to:
https://softwaresupport.hpe.com/web/softwaresupport/access-levels

HPE Software Integrations and Solutions
Visit the Integrations and Solutions Catalog at https://softwaresupport.hpe.com/km/KM01702731 to explore how
the products in the HPE Software catalog work together, exchange information, and solve business needs.
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Application Performance Management
Release Notes
This document provides information about Application Performance Management (APM) 9.30.

What's New in This Release
APM 9.30 includes new functionality, customer escalation fixes, and internal bug fixes. To view a full list of
new features and enhancements in APM9.30, select Help > What’s New in APM, or download the What's
New document from the HPE Software Support site.

APM Support Matrixes
APM system requirements and support matrix information, including APM server and database support
matrixes as well as support and compatibility data for APM data collectors and other APM components, is
now located in the separate APM System Requirements and Support Matrix document, located on the HPE
Software Support site.
Information about supported integrations between APM and other HPE or third-party software is now
available on the HPESW Solution and Integration Portal (requires HPE Passport login). Every integration
listed includes a description of the integration, support matrix, and links to integration configuration
documentation.
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Installation Instructions
For complete instructions on installing this software, see the relevant documentation:
l
l

New customers should follow the instructions in the APM 9.30 Installation Guide.
Existing customers upgrading from BSM 9.25 or 9.26 should follow the instructions in the APM Upgrade
Guide - BSM 9.25/9.26 to APM 9.30.

The most updated versions of these documents are available from the HPE Software Support site.
Note: If you are upgrading to APM 9.30 and are running Red Hat Enterprise Linux 5.x, upgrade your
operating system to Red Hat Enterprise Linux 6.x or 7.x and then perform the upgrade using the Direct
upgrade method.
APM 9.30 Planning Guides Package, which contains:
l

Getting Started Guide

l

Deployment and Capacity Planner (Capacity Calculator)

l

System Requirements and Support Matrixes Guide

l

Database Guide

l

What's New document

APM 9.30 Deployment Guides Package, which contains:
l

Release Notes

l

Database Guide

l

Installation Guide

l

APM Upgrade Guide - BSM 9.25/9.26 to APM 9.30

l

Smart Card Authentication Configuration Guide

l

Hardening Guide
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Updated Components
The following updated components have been released in parallel to APM 9.30 with new features and/or bug
fixes. For more information about the features and fixes included in each component, see the documentation
included with the component. The APM What's New document also lists key new features for updated
components.
Components must be downloaded separately from either the software updates (major/minor releases, e.g.,
9.00 or 9.20) or from software patches (patch releases, e.g., 9.13, 9.23). Both software updates and software
patches can be accessed from the HPE Software Support site (https://softwaresupport.hpe.com).
l

Real User Monitor 9.30
For instructions on installing Real User Monitor (RUM), see the Real User Monitor Installation and
Upgrade Guide, accessible with RUM or from the HPE Software Support site.

l

Business Process Monitor 9.30
For installation instructions, see the Business Process Monitor Deployment Guide, available with BPM or
from the HPE Software Support site.

l

SiteScope 11.32
For installation instructions, see the SiteScope Deployment Guide, available with SiteScope or from the
HPE Software Support site.

l

Data Flow Probe 10.22 CUP 2
For installation instructions, see the Data Flow Probe for APM 9.30 Installation Guide, also available from
the HPE Software Support web site.
Note: APM 9.30 will only work with the version of the Data Flow Probe associated with the 9.30
release. Make sure to download and install the correct Probe from the Software Patches page. The
Data Flow Probe 10.22 CUP 2 setup file is titled HPBSM9.30_DataFlowProbe _10.22CUP2.exe.

l

System Health for APM 9.30
For installation instructions, see the System Health User Guide, available with System Health or from the
HPE Software Support site.
Note: System Health for APM 9.30 will only work with APM 9.30 and not with any earlier versions of
APM.

l

Diagnostics 9.26
For installation instructions, see the following guides, available with Diagnostics or from the HPE
Software Site site:
Diagnostics Server Installation and Administration Guide
Diagnostics Collector Guide
Diagnostics Java Agent Guide
Diagnostics .NET Agent Guide
Diagnostics Python Guide
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Notes and Limitations
Problems and limitations are identified with a Change Request number (QCCRxxxxxxxx). Use this number
when looking for more information about the problem on the HPE Software Support web site
(https://softwaresupport.hpe.com), or when communicating with your HPE Support representative.
To see the most updated status of limitations listed in this section, new limitations published after version
release, or generally to view a list of known problems for a specific product and/or version, on the HPE
Software Support web site sign in and click Search. Select the relevant product, version, and operating
system (for example, Application Performance Management (BAC) > 9.25 > Windows), and select Known
Problems in the Document types area. You can also search for a specific CR using the search box at the
top of the Self-Solve Knowledge Search page.

General and Deployment
As part of the ongoing effort to reduce risk across HPE, if you utilize HP’s GPG/RPM keys, you will have to
update your verification mechanisms to include the new public key. The new public keys are published on the
external website
https://h20392.www2.hp.com/portal/swdepot/displayProductInfo.do?productNumber=HPLinuxCodeSigning
Upgrading BSM 9.2x to APM 9.30: The upgrade from BSM 9.25 or 9.26 to APM 9.30 includes upgrading
RTSM from version 9.05 to version 10.22. The RTSM upgrade results in a change to the RTSM database
scheme.
OMi Removal
l

l

Removal of embedded OMi and PMi (only PMi UI, given we complete the adoption of embedded PMI),
including content manager event console etc.
Removal of integrations such as NNMi, Service Manager (event related only), and BSM Connector will be
supported under OMi. Customers who require OMi related features and functionality can install the OMi
10.11 system in addition to APM and integrate the two products. This is not a dropped functionality but
rather a product adjustment since integration between the products will enable keeping similar use cases.
For additional information, see the OMi Integration Guide
(https://softwaresupport.hpe.com/km/KM02256128).

l

l

The following integrations are no longer supported:
l

Systinet

l

BSM Connector

l

NNMi

l

Enterprise Collaboration

l

AppPulse Active

No OMi related features such as Topology Based Event Correlation (TBEC) and Event Forwarding.

HPE Application Performance Management (9.30)

Page 8 of 41

Release Notes
Notes and Limitations

l

Due to the OMi removal from APM 9.30, SiteScope and Diagnostics will not send events to OMi and
Metrics to APM.
l

l

To enable sending events related to threshold violation in Diagnostics to OMi, see "Diagnostics > APM
9.30 limitation due to OMi removal. (QCCR1I118157)" on page 13 or the APM - Diagnostics Integration
Guide (https://softwaresupport.hpe.com/km/KM02352455).
To enable sending events to OMi and metrics and topology to APM from SiteScope, see the HPE
SiteScope - Integration with APM and OMi (https://softwaresupport.hpe.com/km/KM02377525).

l

SHA will not contribute to APM System Health / MyBSM status which is a mechanism based on events.

l

Business Value Dashboard (BVD) integration for APM data from OMi is not supported.

l

Performance Dashboard (PD) graphing of APM data from OMi is not supported.

APM 9.30 Integration with OMi 10.11: APM 9.30 supports integration with OMi 10.11 and above. Events
from APM 9.30 can be sent to OMi 10.11 as part of the APM-OMi integration. For information about the APMOMi integration, see the OMi Integrations Guide (https://softwaresupport.hpe.com/km/KM02256128).
Features removed in APM 9.30:
l

BPI and TV integrations.

l

SAP, SOA, and Siebel reports.

l

l

Service Health related content (such as HI, KPI, and Business rules) that was managed by the Content
Manager module, is now maintained by def.xml.
App Owner Zone has been removed. Instead, APM 9.30 introduces the new Application Health similar but
expanded functionality.

For a summary of the changes in APM 9.30 links to documentation that contain instructions for how to migrate
these features into APM 9.30, see the BSM 9.25/9.26 to APM 9.30 Migration Notes
(https://softwaresupport.hpe.com/km/KM02391517).
Deployment and Capacity Planner (Capacity Calculator): The Deployment and Capacity Planner (also
known as the Capacity Calculator) is located on the HPE Software Support site.
You use this Excel sheet to input information regarding the scope of your deployment (applications, number of
users, expected data) and the capacity calculator then calculates the required hardware and determines the
size of your deployment. You then use this information to determine your hardware requirements and
deployment configuration. You can upload the data from the capacity calculator Excel sheet while running the
Setup and Database Configuration Utility in the Server Deployment page.
Authentication: APM’s default authentication strategy is Lightweight Single Sign-On (LW-SSO). When LWSSO is enabled, you must use a fully qualified domain name (FQDN) to access APM. This will enable
integration among supported HP applications with a Single Sign-On manager, as well as working with APM
RTSM. If you are not able to provide an FQDN, it is still possible to use IP addresses for LW-SSO-trusted
hosts. For details on working with IP addresses, see “Authentication Strategies” in the Platform
Administration guide.
Temporary Internet Files: When logging into APM for the first time after upgrading, delete the browser's
temporary Internet files. This should be done on each browser that accesses APM .
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Skype Add-ons: An Internet Explorer exception error message is thrown inside APM pages (usually on login
page or in MyBSM), indicating Operation aborted. To resolve this issue, remove the Skype add-ons from your
client. For further details, see http://support.microsoft.com/default.aspx/kb/927917.
Customized version of httpd-ssl.conf file might be overwritten (QCCR1I41178)
Description: If APM is configured for secure access (using Apache + SSL), APM uses a customized version
of the file httpd-ssl.conf on the Gateway Server. This file might be overwritten during the upgrade with a
standard version of the file, breaking the configuration.
Workaround: Before upgrading, backup the customized file <APM root
directory>\WebServer\conf\extra\httpd-ssl.conf. Then reapply the changes to httpd-ssl.conf
using the backup version as a reference to the location of the certificate files.
High Availability Controller cannot move services (QCCR1I46345)
Description: If there is a problem with one of the marble_* processes (for example, one of the processes
cannot start), you must disable the marble_supervisor process. If this process is not disabled, the High
Availability Controller (HAC) cannot move the process’ services (such as the DASHBOARD service that
controls Service Health) to another Data Processing Server if there is a problem with the primary server.
Workaround: Disable the marble_supervisor process. HAC will move DASHBOARD service to another
DPS.
Restart of APM may be required after database outage (QCCR1I46504)
Description: If the management database was down or unreachable and the connection has been restored,
you may have to restart APM.
Workaround: Restart APM when the management database is available again.
Adding additional Gateway servers with differing paths causes login failures (QCCR1I47337)
Description: If two Gateway servers are installed onto different drive paths, for example, one was installed
onto the C:\ drive and the other onto the E:\ drive, APM may not be able to be accessed.
Workaround: Create a duplicate path on the C:\ drive by copying E:\<APM root
directory>\conf\settings to C:\<APM root directory>\conf\settings.
Upgrade will fail if IDM-SSO is enabled in the source environment (QCCR1I58648)
Description: If you are using IDM-SSO, upgrade will fail if IDM-SSO is enabled in the source environment
but not yet configured in the target environment.
Workaround: Disable IDM-SSO on the APM Gateway Server before running the configuration upgrade in the
target environment. To do so:
1. Log into the JMX console (http://<Gateway Server name>:29000) and search for the SSO service
(service=SSO).
2. Locate the setSingleSignOnMode operation and in the ParamValue box, type Lightweight.
3. Click Invoke.
IDM-SSO can be re-enabled after APM is up and running from within APM (Admin > Users and
Permissions > Authentication Management wizard).
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APM 9.30 installation checks for Operations Agent version (QCCR1I123642)
Description: During APM 9.30 installation, if Operations Agent is installed and its version is lower than
11.14.084, a warning message is displayed that APM does not support this version of Operations Agent.

Workaround: This warning is invalid since APM 9.30 no longer supports Operations Agent. Therefore, ignore
this warning and continue with the installation.

Platform
Authentication: When HP Business Service Management is installed with an Oracle Database and User
Synchronization enabled with an LDAP Active Directory server, ensure that you login to HP Business Service
Management with the correct-case UID (uppercase or lowercase), as configured on the LDAP server. This is
because while the Oracle Database is case-sensitive, the LDAP Active Directory is not case sensitive, and
logging in with an incorrect case UID can create undesirable results.
For example, if a user called testuser exists on the LDAP Active Directory server and logs into HP Business
Service Management, he is automatically created as HP Business Service Management user testuser, who
can be assigned permissions in the HP Business Service Management User Management interface. If you
then login to HP Business Service Management as Testuser, the LDAP Active Directory server sends an
acknowledgement that the user exists (because Active Directory is not case sensitive) and he is allowed
entry to HP Business Service Management. However, since the Oracle Database does not identify this user
as testuser (because the Oracle Database is case sensitive), the user Testuser is treated as a new user,
without the permissions that were assigned to testuser.
NLS_LENGTH_SEMANTICS: The recommended setting for Oracle parameter NLS_LENGTH_
SEMANTICS is the default setting of BYTE; setting this value to CHAR may affect database performance.
Infrastructure Settings: Changes to infrastructure settings are not included in the Audit Log.

HPE Application Performance Management (9.30)

Page 11 of 41

Release Notes
Notes and Limitations

Schema Creation: You cannot create a schema that starts with a digit.
Downtime notifications may not be sent if the Data Processing Server is down (QCCR1I44964)
Description: If the Data Processing Server is down for any reason, notifications of downtime starting and
ending during the time period when the Data Processing Server was down may not ever be sent. Notifications
sent to recipients regarding downtimes are configured during downtime creation.
Workaround: None.
Java applets may fail to load (QCCR1I57396)
Description: Java applets may fail to load intermittently.
Workaround: If a Java applet in APM fails to load, clear your Java client cache:
1. In the Windows Control Panel, click Java.
2. On the General tab, select Settings > Delete Files.
Applets fail to load when "Internet Explorer Enhanced Security" is enabled (QCCR1I59140)
Description: In some environments, certain applets fail to load when Internet Explorer Enhanced Security
is enabled on the client machine (for example, the LDAP Group Mapping Wizard).
Workaround: Disable Internet Explorer Enhanced Security on the client machine (for example, Control
Panel > Add/Remove Programs > Add/Remove Windows Components > scroll down to Internet
Explorer Enhanced Security Configuration and uncheck the box).
Login page does not load if accessing through LB in separate domain from APM (QCCR1I60724)
Description: When connecting to APM using an FQDN, you still see the following error in the login screen:
The HPE Application Performance Management URL must include the Fully Qualified Domain Name
(FQDN).
Workaround: Retype the HPE Application Performance Management URL in the address bar, and check if
there is a DNS resolution for Load Balanced virtual IPs from the APM gateways.
MIB validation program returns multiple issues (QCCR1I78961)
Description: MIB validation program returns multiple issues.
Workaround: None.
Personalization for Downtime Management (QCCR1I91787)
Description: Users who are assigned Full Control permission on the Downtime resource can modify all CI
Downtimes (even CI Downtimes created by another user with Full Control permission on Downtimes). The
problem is that users should NOT be able to disable or modify downtimes that they did not create.
Workaround: None.
User names in multiple LDAPs must be unique (QCCR1I102048)
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Description: Users created on different LDAPs with the same user name unite to a single user. Therefore,
user names in multiple LDAPs must be unique.
Workaround: None.
Unable to create Enrichment rule based on new query (QCCR1I119184)
Description: Unable to save Enrichment rule when it is based on a new query .
Workaround: Create query before creating Enrichment rule and use it during rule creation by choosing Base
the Enrichment on an Existing Query option.
APM does not start with manually created schemas on Oracle (QCCR1I119376)
Description: APM does not start with manually created schemas on Oracle.
Workaround: Create schemas on Oracle using the Upgrade Wizard. For details, see the APM Upgrade
Guide - BSM 9.25 or 9.26 to APM 9.30 (https://softwaresupport.hp.com/km/KM02225469).
When APM is configured under non-root user, HornetQ web console cannot be started.
(QCCR1I120696)
Description: When APM is configured under non-root user, HornetQ web console cannot be started. User
gets error: could not find or load main class play.core.server.NettyServer.
Workaround: From the /opt/HP/BSM/bin/ folder under a non-root user account, run the hornetq_
webconsole.sh file.

Integrations
EMS Integration:
l
l

The maximum size of an expression in the EMS Integration configuration file is 4000 characters.
An EMS monitor may not find its configuration file when upgrading the SiteScope version. In such cases,
manually copy the contents of the configuration file to the EMS monitor configuration in the user interface.

In the APM-Diagnostics integration (Admin>Diagnostics) an error occurs on short-name and there
is no way to re-enter the FQDN (QCCR1I62229)
Description: You should use the FQDN when registering the Diagnostics Server with APM . However if you
entered a non-FQDN for the Diagnostics Server you could get stuck in a registration problem loop.
Workaround: Use the URL below and substitute the “topazhost” name in the URL with the FQDN of the
APM Gateway Server to clear the Diagnostics Configuration page in APM:
http://topazhost/opal/uibridge/action/registration.do?action=set_registration&customer_
name=Default%20Client&opal_protocol=&opal_port=&opal_full_host=
Diagnostics > APM 9.30 limitation due to OMi removal. (QCCR1I118157)
In previous releases of BSM, Diagnostics sent CIs, metrics, and events to BSM. Health Indicator status
(coloring) for the Application Infrastructure CIs was based on events sent to BSM through the OMi event
channel.
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In APM 9.30, due to the OMi removal, Diagnostics sends events to OMi and continues to send CIs and
metrics to APM. As a result of this change, the Application Infrastructure CIs (Diagnostic Probe,
Oracle/MSSql Database, IBM WebSphere MQ, WebSphere AS Dynamic Caching, IBM WebSphere MQ,
IBM MQ, WebLogic AS. JBOSS AS, SQL Server, MSSQL Database, Oracle iAS, Oracle, SAP, SAP R3
Server, VMware ESX Server, Host Node) do not show the correct HI Status in APM 9.30.
The HI status for these CIs appears as Undetermined (blue question mark). If you are upgrading from BSM
9.2x to APM 9.30, the last status received for the CI before the upgrade will be displayed.
Workaround: To enable sending events related to threshold violation in Diagnostics to OMi, in the server\bin
directory of the Diagnostics server :
1. Run cscript switch_ovo_agent.vbs -server <FQDN of OMi> -cert_srv <FQDN of OMi>.
2. Go to OMi Administration > Certificate Requests and grant certificates.
3. Run cscript switch_ovo_agent.vbs -server <FQDN of OMi> -cert_srv <FQDN of OMi> again. All
tasks should now display correctly.
SiteScope re-direct to HTTPS APM 9.30 does not work. (QCCR1I118851)
When redirecting SiteScope from BSM 9.26 to APM 9.30 using the staging upgrade, the following error
appears:
“Failed to re-register to HP Business Service Management: Calling to BAC API failed.”
Workaround:
1. Go to APM 9.30 > Administration > System Availability Management.
2. In the Summary pane, select the SiteScope integration and click
be deleted from the SiteScope side.
3. Click

. The integration will automatically

to create the integration again.

Reports and Reporting
PDF: It is not possible to search charts inside reports exported to PDF (since the charts are saved as
images). It is possible to search inside tables.
Export: It is not possible to export chart reports to Excel and XML (CSV is supported).
Scheduled reports do not get sent (QCCR1I66606)
Description: Favorite reports sent using the report scheduler or via Send Now mechanism do not arrive to
recipient email addresses.
Workaround: Ensure that the SMTP sender name setting uses email format. SMTP sender name is set
during installation or in APM from Admin > Platform > Setup and Maintenance > Infrastructure Settings
> Scheduled Reports.
APM/User Reports - Images referenced in the header/footer (pointing to a URL in the Internet) are
lost when exporting the report to PDF (QCCR1I89512)

HPE Application Performance Management (9.30)

Page 14 of 41

Release Notes
Notes and Limitations

Description: Images referenced in the header/footer are lost when exporting the report(s) to PDF. An "X" is
shown instead.
Workaround: Place the image(s) on the APM Gateway Server under:
<APM installation folder>\AppServer\webapps\site.war\images
Access the image in the header/footer as follows: <img src="http://<APM GW>/topaz/images/<image
name>" />

Service Health
Administration
The Rules API enables you to create new business rules for Service Health and Service Level Management,
using the Groovy scripting language. The APM documentation contains basic examples of API rules. For
additional examples of rules based on customer requests, see:
• HPE Live Network: https://hpln.hpe.com/product/operations-bridge/content, in the section Resources >
File Repository > Documentation > Service Health > Rule Descriptions > Custom Business Rule for
HI.docx
• HPE Software Support: https://softwaresupport.hpe.com/km/KM778069
Changing the breakdown configuration does not refresh Service Health components (QCCR1I46143)
Description: In the Breakdown UI, changing the breakdown configuration does not refresh Service Health
components.
Workaround: If you have configured a breakdown in a local impact view (for example, transaction by
location), and you want to change the breakdown type (for example, to location by transaction), you must
perform the following steps:
1. Edit the original breakdown configuration, and select the new breakdown type as None.
2. Save the change, and wait a few minutes for the change to take effect.
3. Select your view, and edit the breakdown type to the type you want defined.
Changes made to triplets not reflected in Service Health calculation (QCCR1I59377F)
Description: If you make changes to the triplets that define impact links within RTSM CI Type Manager >
Calculated Relationships > Triplets, these changes are not reflected in Service Health calculation.
Workaround: After making these changes, access the JMX console (http://<server name>:21212/jmxconsole). Within the UCMDB list of services, select TQL Services, and invoke retrieveTqlNames using
your customer ID. Within the results, search for marble_dashboard_tql, and click Deactivate. When
deactivation is done, click Activate. Service Health calculations will now implement your modified impact
links.
Hidden rule parameters lose their default values (QCCR1I65242)
Description: If you create a KPI assignment that uses a rule with hidden rule parameters, and the
assignment updates an existing KPI with a different rule, the hidden rule parameters lose their default values.
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This typically impacts rule calculations. (Note that this does not apply to new KPIs, but only to existing KPIs
which had a different rule before they were updated by the assignment.)
Workaround: Before updating the assignment, edit the rule definition in the Rule Repository and make the
hidden rule parameters configurable (not hidden). You can then update the rule in the KPI assignment, and
synch existing CIs. After you save the assignment, you can return the rule parameters to be hidden.
Alternatively, you can delete the existing KPIs before running the KPI assignment; this causes the
assignment to create the KPIs rather than update them.
Cannot create local impact pattern view based on the BSMDowntime_impact query (QCCR1I65385)
Description: Within Service Health Administration > View Builder, you cannot create a local impact
pattern view based on the BSMDowntime_impact query.
Workaround: You can create a pattern view based on the BSMDowntime_impact query within RTSM
Administration > Modeling Studio.

Application
The Watch List component in Service Health does not support breakdowns; you cannot add virtual CIs
(breakdown CIs) from a local impact view to a watch list.
PNR KPI Persistency: The PNR KPI in Service Health does not have persistency in case of a Data
Processing Server failure or a system restart. The PNR KPI shows an initialized status until the SLA is
recalculated, at which time the PNR value is updated.
Daylight Savings Time:
l

l

Reports that include the time period during which a Daylight Savings Time (DST) change took place
(change to or change from DST) will either be missing one hour (in cases where clocks are moved forward)
or have two sets of data for the same hour (in cases where clocks are moved back).
If a report’s time range includes the time of a Daylight Savings Time (DST) change, the data for the period
after the DST time change is incorrect. To obtain correct data for the entire time range, print two separate
reports, one for the time range before the DST time change and one for the time range after the DST time
change.

Moving the Configuration Items dialog box can freeze the UI (QCCR1I42825)
Description: Within the 360° View, if you select the Filter icon on the toolbar, and then click the Configuration
Items link, the Configuration Items dialog box opens. If you move this dialog box within the screen, the UI can
freeze.
Workaround: Reselect the component to enable it again.
If the management database goes down, the 360° View suffers a fatal error (QCCR1I46512)
Description: If you are working with High Availability and a load balancer, if the management database goes
down, the 360° View suffers a fatal error.
Workaround: Log out of APM and then log in again.
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Inconsistency displaying breakdown views (QCCR1I47502)
Description: If no new samples were received after a breakdown was defined in a view, and samples were
received from only some of the locations, the view can show inconsistent worst statuses on the locations.
Workaround: None.
Not possibile to reset HI to default (QCCR1I48559)
Description: In the Health Indicators component, the menu command "Reset Health Indicator" to reset an HI
to its default state does not work for metric-based indicators.
Workaround: None.
Only one filter is saved in session per user and customer (QCCR1I52699)
Description: Within the Hierarchy component, only one filter can be used at a time, per user, per customer
(regardless of quick filter or advanced). This means that if a user is using a filter in one Hierarchy component,
and the user then activates a different filter in another Hierarchy component, the first filter is overridden.
Workaround: None.
Filter change done during Web Server or Application Server restart is not saved (QCCR1I62605)
Description: If you are working in a high availability environment with a load balancer, and are editing an
existing filter in Service Health when the web server or application server restarts, changes to the filter are not
saved.
Workaround: None.

MyBSM
JavaScript errors when navigating from MyBSM (QCCR1I47291)
Description: In some versions of Internet Explorer if the browser is configured to show JavaScript errors,
when you navigate from MyBSM to a different application in APM, a popup window appears. This window
contains the following message: Errors on this webpage might cause it to work incorrectly.
This message is not indicative of a problem. Any changes you made in MyBSM are saved, and MyBSM
continues to work correctly.
Workaround: To prevent this message from appearing, within Internet Explorer access the Internet Options
> Advanced tab, and clear the Display a notification about every script error check box.
Performance issues when dragging Component Gallery pop-up in MyBSM (QCCR1I92585)
Description: Performance issues when dragging Component Gallery pop-up in MyBSM. Sometime focus
can be lost and user is forced to regain focus on the pop-up to continue dragging.
Workaround: None.
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Service Level Management
The Rules API enables you to create new business rules for Service Health and Service Level Management,
using the Groovy scripting language. The APM documentation contains basic examples of API rules. For
additional examples of rules based on customer requests, see:
• HP Live Network: https://hpln.hp.com/node/14127/contentfiles, in the section Service Health/Service
Level Management > Tools & Scripts
• HP Software Support: https://softwaresupport.hpe.com/km/KM778069
PNR KPIs: In Service Level Management, you cannot attach more than one PNR KPI (defined in Service
Health) to a CI.
CIs in SLAs: You cannot add a CI to an SLA when the CI includes a copy of itself in the original definition in
the RTSM. This is because nesting is meaningless in the SLA calculation (Service Level Management cannot
calculate a CI using the CI result as a value). If you do so, your operation will fail with a general error.
However, you can add the same CI to an SLA more than once if the CI does not include a descendant of
itself. In this case, Service Level Management calculates the CI only once, so the objectives are the same no
matter where the CI appears in the SLA hierarchy.
Linkage between Business Transaction and SAP Transaction is disabled (QCCR1I47274)
Description: After APM restart, the automatic linkage of Business Transactions to SAP Transactions is
disabled.
Workaround: To enable the linkage mechanism, restart the VERTICALS service in the MercuryAS process.

End User Management
RUM Admin - disable back-end tiers discovery in Generic protocols (QCCR1I64131)
Description: In EUM Administration, automatic tier discovery does not work for the following generic
protocols, even if the Enable automatic tier discovery check box is selected:
l

TCP Request-Response

l

TCP Streaming

l

UDP Request-Response

l

UDP Streaming

Workaround: None.
Error in Alerts tab in End User Management (EUM) Administration when using Java 7u9 plug-in
(QCCR1I79407)
Description: An error may occur when clicking the Alerts tab in EUM Admin if client browser is using Java
7u9 plug-in.
Workaround: Clean Java browser cache and then open the Alerts tab again. To clean the Java cache:
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1. Navigate to Start > Control Panel > Java.
2. In the Temporary Internet Files section, click Settings.
3. In the Temporary File Settings dialog box, click Delete Files.
Failed to create RUM action when using more than 87 Asian characters in name or 166 in
description (QCCR1I89760)
Description: When creating a new RUM action/page in APM and using Asian characters, you are limited to
no more than 87 characters for the name and 166 characters for the description.
Workaround: None.

Business Process Monitor
VuGen Scripts: When you run a script written in VuGen that uses proxy settings from an automatic
configuration script (.pac file) configured in the runtime settings of the script, if one of the proxies in the .pac
file is unavailable, replaying the script in either VuGen or Business Process Monitor may result in a high
response time and, in some instances, the script may fail due to a timeout. The script can be run in Internet
Explorer without this problem, as it ignores the unavailable proxy.
Page Component Breakdown URL: When running a page component breakdown (from End User
Management or Business Process Monitor), the target URL is limited to 144 characters.
BPM instances on Windows
Description: You must run BPM instances on Windows 7 as a system user (default) or as a user with
administrator privileges.
Workaround: None.

Real User Monitor
Some active filters do not work on upgraded RUM data (QCCR1I62276)
Description: When reports are generated for RUM data that has been upgraded to version 9.x, some of the
active filters in the report do not work.
Workaround: None.
RUM reports not available (QCCR1I63076)
Description: RUM reports are not available in APM .
Workaround: If you configure an application for RUM the first time you log in to a new APM system, log out
of APM and log in again before accessing RUM reports.
Client Monitor Probe should be able to capture and report 4xx and 5xx error events (QCCR1I111139)
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Description: Client Monitor Probe does not report HTTP error events, such as 400 series error (page not
found, etc.) and 500 series error (server errors)
Workaround: None.

System Availability Management and
SiteScope
SiteScope Release Notes: Refer to the SiteScope release notes for all SiteScope limitations.
SiteScope Documentation: SiteScope documentation is available only as a standalone help system. It is
not a part of APM Help.
SAM Administration Copy and Paste: In System Availability Management Administration, when copying
objects from one SiteScope to another, there is no dependency check. This means that you can copy an
object that depends on another object to a different SiteScope, even though the object on which it depends
does not exist on the target SiteScope.
SAM Administration Page cannot be displayed error: In System Availability Management
Administration, when the SiteScope service is down, instead of receiving an error to this effect, you will see a
Page cannot be displayed error.
SiteScope Reset: If a SiteScope is being reset when APM is not running, the SiteScope will appear as
registered with a configurable profile in System Availability Management Administration once APM is running
again. The SiteScope must be reset when APM is running.
SAM Administration Recently Used Monitors: On the New Monitor page, the Recently Used Monitors
list is not saved when you exit System Availability Management Administration.
SiteScope Profiles: When creating a SiteScope profile in System Availability Management Administration, if
you change the profile display name after having received any error during the profile creation process, the
default profile name is not changed accordingly. Ensure that the profile name and SiteScope agent machine
location fields contain the desired values.
Monitor Deployment Wizard only supports topology reporting for monitors that have a default
topology defined (QCCR1I39697)
Description: The Monitor Deployment Wizard only supports topology reporting for monitors that have a
default topology defined. This means you can select to add a template to a CI only if the CI type is the default
CI type for all the monitors in the template.
Workaround: None.
After JBoss Application Server recovery, there is no data in SAM Administration "Summary"
(QCCR1I44570)
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Description: After JBoss Application Server recovers from a server crash, the information in the right pane of
the Summary tab in SAM Administration does not show any data until APM is restarted.
Workaround: Restart APM.
408 Request Timeout error in Internet Explorer 7
Description: When accessing SiteScope from System Availability Management Administration using
Internet Explorer 7, a 408 Request Timeout error is displayed.
Workaround: Configure the browser to accept cookies from the SiteScope server.
1. In Internet Explorer, select Tools > Internet Options > Privacy tab > Advanced button.
2. Select Override automatic cookie handling, make sure First-party cookies and Third-party cookies
are set to Accept, and select Always allow session cookies.
Settings when registering SiteScope to a APM server that uses a load balancer (QCCR1I56354)
Description: When registering SiteScope to a APM server that uses a load balancer, make sure that the
Gateway server name/IP address (in Admin > System Availability Management > Distributed Settings)
is the Default Virtual Server for Application Users URL (and not the Default Virtual Server for Data Collectors
URL). This URL can be found in Admin > Platform > Setup and Maintenance > Infrastructure Settings >
Foundations > Platform Administration > Host Configuration table.
Workaround: None.
No reconciliation between SiteScope and Discovery and Dependency Mapping (QCCR1I56709)
Description: There is no reconciliation between SiteScope and Discovery and Dependency Mapping when
there is only a default SQL server instance. SiteScope reports the default value "SQLServer" as the name of
the CI, while DDM reports the name of the host.
Workaround: Install an SQL database with a named instance.
Unable to perform some actions in SAM Administration in a load balancing environment
(QCCR1I58582)
Description: Unable to perform the following actions in SAM Administration in a load balancing environment
when SiteScope 10.x or later is integrated with APM:
l

Copy/paste from one SiteScope to another.

l

Perform a Global Search and Replace.

l

Run the Monitor Deployment Wizard.

Workaround: Register (or remove and reregister) SiteScope to the APM server using the Default Virtual
Server for Application Users URL instead of the Default Virtual Server for Data Collectors URL (enter the
URL in Admin > System Availability Management > Distributed Settings > Gateway server name/IP
address). This URL can be found in Admin > Platform > Setup and Maintenance > Infrastructure
Settings > Foundations > Platform Administration > Host Configuration table.
If you cannot remove SiteScope from APM because you do not want to lose data, you can change the host
name on SiteScope under APM Integration Preferences (Preferences > Integration Preferences >
Business Service Management machine name/IP address).
SISConfigurationEnrichmentUpgrader failure (QCCR1I65694)
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Description: During APM upgrade, SISConfigurationEnrichmentUpgrader may report FAILED, PARTIALLY
FAILED, or NOT REQUIRED status, or the APM content packs may not automatically upload.
Workaround: Delete the blockAutoUpload file located in the <APM root directory>\conf\opr\content
folder.

Run-time Service Model (RTSM)
Installation and Upgrade
It is now possible to manually update the MySQL version on the installed 10.22 Data Flow Probe.
This is an optional procedure for customers who prefer to use the latest MySQL version, and is not
mandatory for an operational probe.
To update the MySQL version on the Data Flow Probe:
1. Log into the machine where the Data Flow Probe is running.
2. Stop the Data Flow Probe (either using a console or the UCMDB Probe service).
3. Stop the MySQL service by opening the Services console and locating the UCMDB_Probe_DB
service.
4. Locate the MySQL installation (for example, C:\hp\UCMDB\DataFlowProbe\MySQL).
5. Rename the MySQL directory to a different name. This step is for backup purposes only.
6. Copy the MySQL.zip file containing the new version to the Data Flow Probe machine and extract it
under the DataFlowProbe directory so that a new MySQL directory is created under it (for example
C:\HP\UCMDB\DataFlowProbe\MySQL directory).
7. Edit the MySQL\my.ini configuration file to contain the correct paths.
For example, if DataFlowProbe is installed under C:\HP\UCMDB\DataFlowProbe directory, update
my.ini to contain the following lines:
# The MySQL server
[mysqld]
basedir = "C:/hp/UCMDB/DataFlowProbe//MySQL/"
datadir = "C:/hp/UCMDB/DataFlowProbe//MySQL/data/"
tmpdir = "C:/hp/UCMDB/DataFlowProbe//MySQL/temp/"
8. Start the MySQL service.
9. Run the clearProbeData.bat script (for example
C:\HP\UCMDB\DataFlowProbe\tools\clearProbeData.bat).
10. Start the Data Flow Probe.
After upgrading a client machine to Java 7 updates 2 or 3, text fields in dialog boxes are not in focus and the
user should manually click on the fields to bring them into focus. This limitation can occur when using the
Internet Explorer and Firefox browsers; it does not occur when using the Google Chrome browser.
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When the Data Flow Probe is configured to be installed in separate mode, so that Manager and Gateway
processes are running on separate machines, the following additional configuration is required on the
Discovery Flow Probe Manager's machine:
1. The Probe Manager must have the exact same Probe ID (appilog.collectors.probe.name) as specified
during the installation of the Probe Gateway.
2. Stop the Manager process (if it is already running).
3. Open <UCMDB installation>\ DataFlowProbe\conf\DiscoveryProbe.properties and locate the
following code:
# The Domain name
appilog.collectors.domain = ${DefaultDomain}
4. Change this code to contain the Data Flow Probe's actual domain. For the default domain,
DefaultDomain, this code should look as follows:
# The Domain name
appilog.collectors.domain = DefaultDomain
5. Save DiscoveryProbe.properties and start the Manager process.
After upgrading to the latest APM patch, if a job's time zone setting was other than "Discovery probe time
zone", it must be reconfigured to the correct time zone.
When upgrading from previous versions of BSM, if you enabled Update/View permissions in the Data Flow
Management modules, but did not enable the Execute permission, you must manually re-enable those
modules by selecting the Execute/Update permission for the relevant users. For the Adapter Management,
the permission should be set to Update.
If integrations are configured under RTSM Integration Studio (for example, topology synchronization
integrations between central UCMDB and RTSM), after upgrading, the Data Flow Probe will run population
jobs immediately for active integration points, even if the integration is not scheduled. If you do not want the
integration to run, disable the integration before running the upgrade from any BSM 9.x version.

Application and Modeling
Hidden queries are no longer displayed in Package Manager by default. To display hidden queries in Package
Manager, go to User Preferences and change the value of the Show hidden queries in the Modeling Studio
user preference to true.
If a TQL query containing a federated history query node fails to calculate when using the Changed during x
hours operator, redeploy the CmdbHistoryAdapter located in the ..\<Data Processing Server root
directory>\odb\content\adapters directory.
The APM server may not start up properly when the setting Max CIs in view supported to rediscover in the
Infrastructure Settings Manager is set to very high values.
When creating a cron expression in the Job Definition Scheduler, the time and date must be in the future. If
the current date or a past date is defined, it will cause an error.
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When Delete permission is assigned for a CIT, all of its sub-classes can also be deleted.
When Create permission is assigned for a CIT, it can be updated and all of its sub-classes can also be
created.
In Enrichment Manager, Impact Analysis Manager, and CIT Manager, when you select several CITs and their
connecting relationships and select Export Map to Image with the Selected Object Only option, the
resulting image does not display the relationship names.
It is possible to edit CITs even if they are assigned the READ_ONLY_CLASS qualifier.
The Screen Capture tool cannot capture a screen shot when the UCMDB/RTSM browser is running in a multidisplay environment.
The Clear Filter button in the Job List dialog box (for scheduled reports and scheduled snapshots) does not
work properly.
When creating a new Impact rule in the Impact Analysis Manager, the created Impact rule can be run within
the IT Universe Manager even if the UCMDB check box on the Impact Rule Groups page of the wizard is not
selected.
In IT Universe, if you right-click a Virtual Compound Link from the Get Related pane, the Show Compound
Path option is disabled.
The following API has been added to the CI Selector to get the selected CIs' display labels and class names
using Javascript:
l
l

String getSelectedCmdbObjectDisplayNames()
String getSelectedCmdbObjectClassNames()

The new retrieveAllActiveUsers() method is now available in the UCMDB-UI:name=UCMDB Integration
section of the JMX console. This is equivalent to the getAllActiveUsers() method that was available in
UCMDB version 8.0x.
In the UCMDB_JavaAPI, in cases where an attribute type was of type string or integer list, the
Attribute#getDefaultValue() method, which had returned strings in XML format, now returns a collection of
string or integer objects.
There have been some performance improvements in the Generic Database Adapter.
In the Views tab in the Security Manager, when Delete permission is set and a view is deleted, the query on
which the view depends is also deleted.
When working in multi-customer environment (such as SaaS), you must work with a single database and
schema.
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In the Modeling Studio, it is not possible to create more than one pattern-based model of the same CI type,
based on the same query. When you try to create a new one, it overwrites the existing one.
Deprecated CI types do not appear in strike through font if the font size is less than 14 points.
In the Routing tab in the Layout Properties dialog box, (accessed by selecting Layout > Layout Properties),
all the options seem to be available, but only some of them are actually used in the layout of the map.
In the Impact Analysis Manager, if an XML file is imported with the same file name as an existing Impact
Rule, a confirmation message saying that an Impact Rule of that name already exists is not displayed before
replacing the existing Impact rule.
When exporting CI instances found for a selected TQL, you can now manually enter up to 150,000 CIs per
page.
If you have Delete permissions for views and you delete a view, the TQL query on which the view depends is
also deleted.
In the Modeling Studio, no informative error message is displayed when you import an invalid XML file for
views or queries.
In Modeling Studio, you cannot change the query type of an Enrichment or Impact Analysis query in the Query
Definition Properties dialog box if there are resources that are defined on top of this query.
In the Impact Analysis manager, when you try to save an Impact rule for which you defined a sub-graph, a
generic error message appears without giving detailed information regarding the problem.
Printing semi-transparent graphics using the Run Screen Capture Tool produces poor quality results.
In the Hierarchical tab in the Layout Properties dialog box, (accessed by selecting Layout > Layout
Properties), the Minimum Backward Edges and Optimize For Feedback Flow options do not work
properly.
The new viewing system currently does not support displaying view results via the IT Universe Manager that
were based on a rule-based template.
When displaying CIT instances with the network port number property, the network port number is displayed
with a comma. This comma is irrelevant but is displayed because of the manner in which Java reads the value
from the system.
When you search for a string in the Modeling Studio or the Reports module, the Highlight button highlights
only the first occurrence of the string that is found.
When a calculated relationship is selected in Enrichment Manager or Impact Analysis Manager, the Qualifier
tab in the Relationship Properties dialog box is not functional (the qualifiers selected are not applied to the
selected relationship).
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When creating a view based on a new TQL query in Modeling Studio, if you add a condition to one of the query
nodes and save the view, and then modify the view topology without closing the window, an error is
generated. To avoid the error, close the window after adding the condition and saving the view, and then open
the view again and make the topology changes.
The Show Element Instances dialog box does not display the External icon for federated CIs.
The Hierarchy Pane of the Pattern View Editor in Modeling Studio does not display the External icon for
federated CITs in the TQL query.
When editing an out-of-the-box attribute of type byte, an error is generated. For example, when editing the
AttachementContent attribute of an Attachment CI, an error occurs. User-created attributes can be edited
safely.
You can set the starting date and time and repeat interval for pattern-based model updates using the Pattern
Based Model Scheduler dialog box in the Modeling Studio. Select Daily Pattern Based Model Scheduler
Updates to set the repeat interval in hours. Select Advanced Pattern Based Model Scheduler Updates to set
the repeat interval using a cron expression.

Confidential Manager
If you change the default domain name in RTSM, you must first verify that the Data Flow Probe is not running.
After the default domain name is applied, you must execute the DataFlowProbe\tools\clearProbeData.bat
script on the Data Flow Probe side, and then restart the Data Flow Probe.
Note: Execution of the clearProbeData.bat script will cause a discovery cycle on the Probe side once the
Probe is up.

Discovery
When setting up the Data Flow Probe, if you import illegal ranges from a CSV file (for example, the start IP is
higher than the end IP), no error is displayed, and the range is saved. You must fix the invalid range manually.
SQL Protocol: The Encryption Method field enables you to choose SSL support for Oracle connections.
SNMP Protocol: The Privacy Algorithm now supports both DES and AES algorithms.
If you want to connect a new Data Flow Probe to RTSM with an identifier of a Data Flow Probe that is already
defined on a different domain, you must remove the existing Probe from RTSM (from the Data Flow Probe
Setup module), prior to installing the new Probe.
To prevent an overload on the Data Flow Probe machine, you can limit the number of remote processes that
run simultaneously. Locate the appilog.agent.local.services.maxRemoteProcesses parameter in the
DiscoveryProbe.properties file. The default value is unlimited (-1). Change the value to the maximum
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number of processes that can be run simultaneously. If you change this value, you must restart the Probe.
(This overload can occur when activating certain out-of-the-box jobs that launch a Java process for each
destination, for example, J2EE or SAP jobs.)
Downloaded jar file resources can cause the Probe to restart before all the other resources of an adapter
package have downloaded. To prevent this occurring, the reset time is, by default, 40 minutes. You can
change this time:
Access the appilog.agent.probe.restartProbeAfterJarDownload.interval parameter in the
DiscoveryProbe.properties file. The delay until a restart on the first resource download (that is, for a first
start or after clearing the Probe data) is 10 milliseconds.
In the Dependency Map, when selecting to show all instances of a selected CI, the instances are not
displayed.
When you try to filter triggered CIs by probe in the Discovery Control Panel - Status pane, the triggered CIs
are not filtered.
Discovery job error and warning messages are displayed in the language of your client's operating system,
independent of browser language settings.

Integration
It is now possible to disable the reporting of null values in the GDBA adapter by adding in the adapter's
adapter.conf file the following setting: report.null.values=false.

Integration job for syncing (population syncing) between RTSM and CMS is limited to 500,000 CIs
and relationships (QCCR1I79192)
Description: The integration job that is defined to sync (population sync) between the RTSM and CMS (or
another instance of RTSM) and vice versa, is limited to 500,000 CIs and relationships. This is a limitation of
live TQL queries. This limitation applies to all sync jobs that pull data simultaneously from the same
CMS/RTSM – they are restricted to a total of 500,000 CIs and relationships.
When syncing data from UCMDB/CMS 10.01 CUP 5 and up to RTSM, it is recommended to use the push
sync adapter on the CMS side instead of population. This sync method is limited to 5 million CIs and
relationships per sync job.
If you are using data synchronization between APM and the central CMDB or OMI's RTSM with aging
enabled in the adapter, if you disable the sync for a time period which exceeds the aging interval, CIs may be
deleted by the aging mechanism. As a result, related data and configurations in APM may be lost as well.
Workaround: If you plan to stop data synchronization between APM and the central CMDB for a time period
which exceeds the aging interval, it is recommended to disable the aging in the adapter. If the aging has been
enabled and is changed to be disabled, it is recommended to run full data synchronization before stopping the
data synchronization between APM and the central CMDB. (QCCR1H65590)
When running a history-based push job (for changes), you can incorrectly select any integration TQL query,
even those that are federated or contain virtual links.
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If you start a population job (for the first time) on a TQL query that is currently being edited, saving the query
may remove its "Active" status and cause the job to fail. If this occurs, running a full population job again will
fix the problem.
A population job that uses the UCMDB 9.x adapter to retrieve federated data can retrieve only added or
updated CIs, but cannot remove deleted CIs from the CMDB.
The EMC Control Center (ECC) database does not contain WWN (World Wide Name) information for
FCHBAs (Fiber Channel Host Bus Adapters) attached to Storage Arrays. Therefore, this discovery populates
the WWN attribute of FCHBA CIs with the ECC ID (internal to ECC) of the HBA. The script also populates
the data_note attribute of each such FCHBA CI with a note that ECC does not have WWN info and
duplication of this CI is possible.

Discovery and Integration Content
For details on the Discovery and Integration Content Pack versions compatible with this version of APM, see
the APM System Requirements and Support Matrixes Guide associated with the version of APM you are
installing.
Child CIs are no longer included in reconciliation rules when considering identification for Business
Applications. An optional identifier based on the ID (App_ID) can be used to uniquely identify each Business
Application CI. Business Applications that are synced from external sources must have a unique name or ID
in order to be included during data synchronization. Note that multiple Business Applications with the same
name and no ID will not be synchronized.
Additional CI types for which child CIs are no longer included in reconciliation rules are Business Process,
Business Service, CI Collection, Business Transaction Flow, and Dynamic Node Group. No optional
identifier can be specified for these CI types.
Content Pack Documentation Updates
To read the latest versions of the relevant documents, access the following URLs:
l

l
l
l

<http://SERVER_NAME:PORT/ucmdb-ui>/docs/DDMContent.jsp – Discovery and Integration
Content Guide
<http://SERVER_NAME:PORT/ucmdb-ui>/docs/permissions.jsp – the Permissions document
<http://SERVER_NAME:PORT/ucmdb-ui>/docs/readme.jsp – the Release Notes (this file)
<http://SERVER_NAME:PORT/ucmdb-ui>/docs/whatsnew.jsp – What's New in this release

RTSM Multilingual Support
Multi-Byte characters do not appear in titles and sub-titles in reports when exporting or previewing as PDF.
For reasons of compatibility, Integration Point names and Data Flow Management job names can include only
English letters, numbers, and the underscore character (_).
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Because the maximum string length for many UCMDB parameters is defined and documented in bytes, the
real acceptable value length is shorter when multi-byte or language-specific characters are used.
In Enrichment Manager, required attributes in the Node Definition dialog box are not marked in bold for the
Japanese, Chinese, and Korean versions.
Non-English characters should not be used in paths to different properties or adapter files.
Multi-byte characters should not be used in user passwords.
The action names in scheduled jobs are stored with localized names (according to the locale being used), but
those names are displayed with no dependence on locale. Those action names may be user-modified and
therefore will be user-specific.
Excel can now open UTF-8 encoded CSV documents correctly.
HP Universal CMDB/RTSM does not fully support surrogate pairs and combining characters.

Business Process Monitor (BPM)
Performance issues occur when running UFT 12.02 scripts in BPM 9.25 on Windows 7 32 bit
(QCCR1I103866)
Description: A decline in BPM machine performance occurs after several hours of running UFT 12.02 scripts
on BPM 9.25 on Windows 7 32 bit.
Workaround:
Use UFT 12.01 scripts or run BPM on Windows 7 64 bit.

Documentation
The note about accessing the JMX console from the localhost in the JMX Console chapter of the APM
Platform Administration Guide and the instructions in How to Enable Accessing JMX Console Remotely in
this chapter only applies to JMX ports other than 8080 (for example, 21212). To secure access to the JMX
console through port 8080, see the instructions in Secure JBOSS Management API (http JMX) on BSM
servers in the Hardening Workflow chapter in the APM Hardening Guide.
The section on Integrating Multiple CMDBs in the RTSM Data Flow Management Guide does not contain
support information for recent BSM releases. For the complete BSM-CMS support matrix, refer to the BSM
System Requirements and Support Matrixes pdf.
In the BSM Help, the previous and next buttons do not function for the Run-time Service Model (RTSM),
Monitoring Automation (MA), User Engagement (UE), or Management Processor (MP) topics.
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Multilingual Support
User cannot change currency symbol in SHA (QCCR1I70497)
Items in component gallery are not translated; Service Health top pane tabs (Page Names) are not
localized (QCCR1I69138, QCCR1I45575)
Unreadable characters in command line interface help (QCCR1A139904)
Description: There is a general problem with printing localized unicode text on the Windows command line.
Due to limitations in the default console font and the wrong code page being in place, certain characters do not
display correctly.
A detailed description of this problem can be found at :
http://illegalargumentexception.blogspot.com/2009/04/i18n-unicode-at-windows-commandprompt.html#charsets_1252
Workaround: In the console window on Windows perform the following actions:
1. Open the properties of the command window (right-click on the frame and select Properties. Switch to
the Font tab and change the font to Lucida Console.
2. Click the OK button to close the properties dialog box. The new font setting is used for all future
command prompts.
3. In a command window, enter the following command:
chcp 1252
All command line tools should now display with the correct localized text.
Application > Service Health top pane tabs (Page Names) are not localized (QCCR1I45575)
The RTSM Class Model does not support multi-byte character sets. All class model items, including
CI type, relationship, and attribute names, descriptions, and display labels, cannot contain multibyte characters. (QCCR1I62755)

Diagnostics
Diagnostics - no support for non-English characters in Java and .NET Probes names
(QCCR1I57918)

SiteScope
Run results for some monitors are shown according to the server locale or in English, instead of
the client locale (QCCR1I30190)
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Localized Service names are not readable while trying to add a Service monitor on WMI remote
host. Workaround – use NetBios. (QCCR1I30808)
When using the Microsoft Windows Resources monitor in a non-English locale, the monitor
counters and run status summary are not readable. Workaround: Configure the monitor to use the
Direct registry queries collection method. (QCCR1I54985)
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Fixed Issues
This section lists fixed problems and limitations for APM 9.30 that have been made visible to customers for
tracking in the HPE Software Support web site (https://softwaresupport.hpe.com).
For a complete list of the problems and limitations fixed in this release that have been made visible to
customers for tracking:
1. Navigate to the Self-Solve Knowledge Search page, on the HP Software Support web site
(https://softwaresupport.hpe.com).
2. Select the relevant product, version , and operating system (for example, Application Performance
Management (BAC > 9.30 > Windows).
3. Under Document Type, select known problems.
4. Click the issue that you want to view (or download). A page containing information about the issue
displays.

If a running KES assignment becomes invalid and a user fixes it, the assignment is revalidated but
remains stopped (QCCR1I61778)

Symptom:
User creates a KES assignment and goes to Repositories and performs a change that makes the assignment
invalid, for example, delete the KPI from Repositories. In the KES UI the user wants to fix the assignment, for
example, choose a different KPI. The assignment is valid but now - for some reason - the assignment is
stopped.

Resolution:
The bug was fixed so now when we revalidate the assignment and find it INVALID we only set the Valid flag
to false and the Running flag is still true. The KES Engine knows to ignore invalid assignments even if they
are running.

When exporting a custom report in CSV format, the Response Time is not correct. (QCCR1I115508)

Symptom:
When exporting a custom report in CSV format, the Response Time is not correct.

Resolution:
The Response Time is now correct according to the locale definition.
Misleading IndexOutOfBoundsException when a APM service user does not have sufficient
permissions to read from the jmxremote.password file (QCCR1I111681)
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Symptom:
Misleading error in logs when a APM service user does not have sufficient permissions to read from the
jmxremote.password file.

Resolution:
Now logs show correct error in case of insufficient user permissions. For example: 2016-03-14 17:51:39,397 java.lang.Exception: Failed to get RMI-JMX security credentials from password file "...". Please check if
APM service user have sufficient permissions to read from file.

"Failed to open single page mode" error when using "Link to This Page" with "Embedded link"
checkbox/option selected. (QCCR1I117115)

Symptom:
"Failed to open single page mode" error when using "Link to This Page" with "Embedded link"
checkbox/option selected.

Resolution:
A partial URL was used, which is now fixed.

Wrong value in Application Availability and in Application Performance KPIs, when sending a
sample with response time = 0.0 (QCCR1I112423)

Symptom:
Wrong calculation of KPIs based on groovy scripts

Resolution:
Calculations are now correct. Transactions with response time = 0 were not included in the performance
calculation.
JBoss does not start when there are two enabled NICs (QCCR1I116285)

Symptom:
JBoss does not start when there are two enabled NICs.

Resolution:
Problem fixed. JBoss now uses the IP address rather than host name to connect to HornetQ.
The rebuild_fragmented_indexes.bat rebuilds the same index multiple times (QCCR1I116317)

Symptom:
The rebuild_fragmented_indexes.bat rebuilds the same index multiple times
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Resolution:
Eliminated duplicate rows from rebuild index plan.
It is not possible to configure two different Breakdown Calculation Rules (QCCR1I112730)

Symptom:
It is not possible to configure two different Breakdown Calculation Rules for CIs sharing the same parent. The
following error is displayed: "There is a conflict between two breakdown configuration rules. CI xxx has a
breakdown configuration calculated with Worst Status while XXX has a breakdown configuration calculated
with Best Status...."

Resolution:
It is now possible to configure two different Breakdown Calculation Rules for CIs sharing the same parent.

In Infrastructure Settings, create a new setting so that specific groups can be assigned to those
LDAP users who are not assigned to any group (QCCR1I92859)

Symptom:
In Infrastructure Settings, create a new setting so that specific groups can be assigned to those LDAP users
who are not assigned to any group.

Resolution:
Created a "Default LDAP Group unique ID" setting in the LDAP Global Configuration part of the Infrastructure
Settings. To assign this group to the LDAP users, who are not assigned to any group, do the following: 1.
Create/choose a group in BSM. 2. Obtain unique ID of this group in GROUPS_AUTH table of MNG DB. 3.
Select GRP_GROUP_ID from GROUPS_AUTH where GRP_GROUP_NAME='group_name'. 4. Set this
value to "Default LDAP Group unique ID" setting. This group will be used for all LDAP domains to move in
users which do not belong to any mapped groups in LDAP.
APM EUM Alert documents do not clearly specify that EUM Alert messages are delayed for 60
seconds after being triggered and before being further processed (QCCR1I117337)

Symptom:
APM EUM Alert documents do not clearly specify that EUM Alert messages are delayed for 60 seconds after
being triggered and before being further processed and sent to allow dependency calculation.

Resolution:
Added a note to the Application Administration > End User Management > End User Management Alerts
Administration > Alerts Dependency chapter that EUM Alert messages are delayed for 60 seconds in order to
allow dependency calculation.
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In the EUM Alerts CEM templates, the CI Hint based on BTF ID returns a BTF name for time-based
alerts (QCCR1I114827)

Symptom:
In the EUM Alerts CEM templates, the CI Hint based on BTF ID returns a BTF name for time-based alerts.

Resolution:
CI Hint based on BTF ID now returns BTF ID for all the trigger types.
EUM X out of Y Alert <Data Collector Name> parameter is wrong when alerts triggered from
multiple locations (QCCR1I107663)

Symptom:
EUM X out of Y Alert <Data Collector Name> parameter is wrong when alerts are triggered from multiple
locations: the first Data Collector where a failure was registered is returned instead of the last one.

Resolution:
Alert parameters now contain the last data collector where a failure was registered.

While generating an Alert Log report for an alert name containing a single quote (') character, an
error message indicating that the selected alerts list is empty appears (QCCR1I108224)

Symptom:
While generating an Alert Log report for an alert name containing a single quote (') character, an error message
indicating that the selected alerts list is empty appears.

Resolution:
The single quote (') character is added as a supported character for alert names.
Hierarchy Personalization does not get saved after a user logs out of APM (QCCR1I116153)

Symptom:
Hierarchy Personalization does not get saved after a user logs out of APM

Resolution:
This release fixes the defect by updating the personalization codes.
Unable to change the password for the profile database through the APM User Interface
(QCCR1I77049)

Symptom:
Unable to change the password for the profile database through the APM User Interface.
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Resolution:
Fixed the unexpected behavior in the Database Management tab.
Navigation from OMi to APM and then back to OMi caused an Internal Error message to be
displayed (QCCR1I114250)

Symptom:
Navigation from OMi to APM and then back to OMi caused an Internal Error message to be displayed.

Resolution:
This release fixes the defect that caused the unexpected internal server error message to display.

On the CI Indicators tab, after removing the "Default Menu" from some CIs, and then switching to
another tab, the context menus related to the CIs appear again (QCCR1I85630)

Symptom:
As per the KPI Assignment tab, some CIs, like the SiteScope Monitors, have "Default Menu" assigned as
part of the default context menus. On the CI Indicators tab, after removing the "Default Menu" from some CIs,
and then switching to another tab, the context menus related to the CIs appear again.

Resolution:
Fixed the unexpected behaviour in the CI Indicators tab.
HornetQ messages accumulate and the events are not processed if the marble supervisor is
restarted (QCCR1I117375)

Symptom:
HornetQ topics ESS_Marble_Topic_1 and opr_store_update_event_topic messages accumulate and the
events are not processed if the marble supervisor is restarted.

Resolution:
Fixed HornetQ client's re-connection process.

If the email recipient list has an invalid email address, notification emails (reports and alerts) are not
sent even to the valid email addresses (QCCR1I108240)

Symptom:
If the email recipient list has an invalid email address, notification emails (reports and alerts) are not sent even
to the valid email addresses.
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Resolution:
Added an ability to re-send notification emails to the valid email addresses.
Internal error if no recipient was defined (QCCR1I113660)

Symptom:
Internal error if no recipient was defined.

Resolution:
Fixed the internal error if no recipient was defined.

In Custom Reports opened with browser configured to use Spanish locale, timestamps are shown
in AM/PM format instead of 24h format (QCCR1I66281)

Symptom:
In Custom Reports opened with browser configured to use Spanish locale, timestamps are shown in AM/PM
format instead of 24h format.

Resolution:
Fixed the timestamp format error for browsers configured to use Spanish locale.
Add SSL protocol support for communicating with SMTP servers so that users can use Google
Apps as the SMTP server for APM (QCCR1I66212)

Symptom:
Add SSL protocol support for communicating with SMTP servers so that users can use Google Apps as the
SMTP server for APM.

Resolution:
Added SSL\TLS protocol support.
Error Log report is not sorted correctly in some cases upon drilldown from Performance Raw Data
report (QCCR1I115402)

Symptom:
After changing the order of time of the Performance Raw Data report and running the Error Log for a second
time, the records of the drilldown Error Log reports are not sorted in correct order.

Resolution:
The defect has been fixed by applying Personalization settings.
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SysH JMX monitor causes large number of JMS connection WARNINGS to appear in jboss-as
server.log resulting in file system flooding (QCCR1I116385)

Symptom:
SysH JMX monitor causes large number of JMS connection WARNINGS to appear in jboss-as server.log
resulting in file system flooding

Resolution:
Now, when System Health BUS monitors are run, all the open connections for all subscribers are properly
closed.

On Linux systems, in System Health template, the UNIXNannyProcessRemoteMonAlerted service
name "hpbsmd " has blank space at the end (QCCR1I116554)

Symptom:
On Linux systems, in System Health template, the UNIXNannyProcessRemoteMonAlerted service name
"hpbsmd " has blank space at the end. Due to this, the the monitor returns an error.

Resolution:
The blank space at the end of the service name is removed in this release.
System Health reports from Dashboard icon do not work in SSL mode (QCCR1I114692)

Symptom:
System Health reports from Dashboard icon do not work in SSL mode.

Resolution:
Reports can now be generated in SSL mode through port 8899.

In the System Health Guide, add a note about configuring templates.xml in multi-gateway
configuration (QCCR1I115619)

Symptom:
In the System Health Guide, add a note about configuring templates.xml in multi-gateway configuration.

Resolution:
Added note in the System Health Guide - In a multi-gateway configuration, update the templates.xml file for
each gateway server.

In custom reports, personalizations made to the columns do not get saved when the report is sent
according to its schedule (QCCR1I88172)

HPE Application Performance Management (9.30)

Page 38 of 41

Release Notes
Fixed Issues

Symptom:
In custom reports, personalizations made to the columns do not get saved when the report is sent according
to its schedule. This problem is not seen when using “Send email now” option.

Resolution:
Scheduled Reports are now run as admin with personalization of a user that scheduled the report. Scheduled
reports run as admin now retain the personalizations settings of the user who scheduled the report.

On Firefox browser, Trend Report does not display horizontal scrollbars after Monitor Type
selection (QCCR1I115720)

Symptom:
On Firefox browser, Trend Report does not display horizontal scrollbars after Monitor Type selection.

Resolution:
Applied fix to the code to align the column widths with the text widths to avoid usage of scrollbar.
Personalizations made to the columns on user reports do not get saved (QCCR1I88456)

Symptom:
Personalizations made to the columns on user reports do not get saved.

Resolution:
Personalizations made to the columns on user reports are now saved.
Too many decimal places in Service Reports (QCCR1I83895)

Symptom:
Too many decimal places in Service Reports.

Resolution:
Added option under the advanced settings to specify decimal places as needed.
Resize context menu reports popup to eliminate scrollbars (QCCR1I77904)

Symptom:
Resize context menu reports popup to eliminate scrollbars.

Resolution:
Resized the reports popup to eliminate scrollbars.
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Transaction names in MyBSM reports are unreadable (QCCR1I116905)

Symptom:
Need the following functionality for the MyBSM Metrics Over Time component: 1. Ability to adjust the legend
position (and if possible, the size), so that it could be placed below the graph. 2. Ability to change the labels of
the legend components manually (only the labels in this component, not the actual action/transaction/etc
names).

Resolution:
The parameter used to calculate the width is changed.
Hierarchy portlet in MyBSM filters does not allow proper filtering on views (QCCR1I96230)

Symptom:
Hierarchy portlet in MyBSM filters does not allow proper filtering on views

Resolution:
Views with unsupported number of nodes will now immediately display a warning.
Custom image in Service Health is sometimes not available after an image update (QCCR1I114085)

Symptom:
Custom image in Service Health is sometimes not available after an image update.

Resolution:
Fixed the issue of custom image in Service Health being not available after image update.
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an email
client is configured on this system, click the link above and an email window opens with the following
information in the subject line:
Feedback on Release Notes (Application Performance Management 9.30)
Just add your feedback to the email and click send.
If no email client is available, copy the information above to a new message in a web mail client, and send
your feedback to SW-Doc@hpe.com.
We appreciate your feedback!
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